
About  iMovie 
iMovie is a free application for Mac users that is designed to capture, edit, and playback video. It's ease of use 
and high quality make it ideal for creating instructional videos in the classroom.

iMovie  Controls
Below you see the iMovie screen and the controls that are used to create movies. An explanation of the use of 
each follows:

Monitor: Preview your video clips in this window.

Shelf: bins where captured video clips are imported and organized.

In/Out points: Select an area in the Scrubber Bar to copy portions of a video clip and paste into the Clip/
Timeline Viewer. You extend the selection by dragging the small triangles.

Camera/Edit Mode: Selects Camera or Edit mode.

Playback Controls: Controls playback of movie or the operation of the camera depending on whether 
Camera or Edit mode is selected.

Clip/Timeline Viewer: Area where you add/edit video clips, sound, music and pictures by applying 
transitions, titles and filters.

Playhead: Cursor that shows exactly where you are in a clip or movie.
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Scrubber Bar: Scroll within a single clip, or the whole movie.

Volume Control: Set volume for preview playback.

Menu Pane: Menus for adding filters, transitions, music and sounds.

Trash: Holds deleted files such as trimmed clips, sounds and pictures.

Free Space: Shows amount of hard drive space available.

Connecting a DV Camera

Connect your DV camera to your computer using a 6-pin to 4-pin Firewire cable. Turn the camera on and set 
the camera to VCR mode. The words Camera Connected should appear in the Monitor window. If you see 
the message No Camera Attached, click the Camera button. 

Controlling  the Camera

You DV camera is controlled by iMovie when you click on the Playback Controls. Use these buttons to 
rewind, fast forward, pause, play and stop. Make sure your camera is cued up to the place you want to start 
capturing from.

Capturing Clips
To start capturing clips, click the Import button above the Playback Controller. The clips will be automatically 
imported onto the Shelf. iMovie detects the end of a each video clip (where you stopped recording) and starts 
a new clip in the next Shelf bin. When you have all the clips you want, press the stop button.

Editing Video Clips
To edit video clips in iMovie do one of the following: Select and Delete, Select and Crop, Duplicate and 
Split Clip at playhead. Each of these can be undone by selecting Undo from the Edit Menu or pressing 
Command-Z. You can  only Undo the last action performed.

Deleting
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Select the part of the clip that you wish to delete by dragging the in/out arrows and then press the delete key. 
Deleting from the middle of a clip will create two clips - one for each end.

Cropping

Select the part of the clip that you wish to keep by dragging the in/out arrows and then select Crop from the 
Edit Menu or pressing Command-K. This deletes the beginning and end of the clip.

Duplicating

Select a video clip or a part of a video clip that you wish to duplicate. Copy it by selecting Copy from the Edit 
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Menu or by pressing Command-C. Move your play head in the Timeline, to the place you want to Duplicate 
the video clip and paste it by selecting Paste from the Edit Menu or pressing Command-V. You can also 
duplicate a video clip in the Clip Viewer by Option-click and drag.

Splitting Clip at Playhead

Move the playhead to the point at which you wish to split the video clip. Select Split Clip at Playhead from 
the Edit Menu or press Command-T.
The clip will be split into two parts. The new clip will be identified by a slash between the clip name, ex: Clip 
12/1

Sequencing 
You can rearrange the order of the video clips in the Clip/Timeline Viewer at anytime. Keep in mind that 
transitions or titles may have to be re-rendered if you move them. It is best to place the video clips in the order 
you want before adding titles and transitions.

Titles

Previewing a Title
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Click on the Title pane. A list of titles that are available are displayed in a scroll box. When you click a title 
name, a preview of the title is displayed in the Title preview window at the top. The title preview will be 
superimposed over which ever video clip you have selected.

Adjusting the Duration of a Title

Change the duration of the title by dragging the speed slider to the left or right. Change the pause time of the 
title (how long the title stays on the screen) by dragging the pause slider to the left or right. The preview will 
change according to your settings. The numbers in the preview window from left to right show the speed + 
the pause = the length of the title.

Adding and adjusting your text

Each Title will have a text box to enter your text.  The amount of text that you enter depends on the type of 
title, credit or caption that you have selected. You don't have to add text to all text boxes.

After entering your text, select a font from the font popup menu. Change the size of the text by moving the 
Size slider from left to right. Make sure to choose a font that will be readable. Arial, Helvetica and Verdana 
are good choices.

Change the color of the text by clicking on the color well next to the font popup list. Choose a color that 
contrasts with the background you will be superimposing on. If you want the title to appear over a black 
background, click the Over black check box.

If you have selected a title that is animated, ex: Cartwheel, you can change the direction of the animation by 
clicking the appropriate arrow in the direction wheel. Select the arrow that points the direction of travel you 
want the letters to go.

Applying your Title

To apply a title to a video clip, move the playhead to the exact position you want the title to begin. A title can 
not be added to a video clip that already has a transition. If you've selected a point that is part way through a 
clip then split the clip. Drag the title name from the popup list of titles directly into the Clip/Timeline viewer 
and release it where you want it superimposed. The other video clips will automatically adjust to fit the new 
title.

Rendering a Title

Each title has to be rendered before you can preview it. A red line along the bottom of the video clip indicates 
the rendering progress. You can continue to work editing other video clips while rendering takes place.

Transitions
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Previewing a Transition

Click on the Transition pane. A list of transitions that are available are displayed in a scroll box. When you 
click a transition name, a preview of the transition is displayed in the Transition preview window at the top. 
The transition preview will execute between which ever video clips you have selected.

Adjusting  a Transition

Change the duration of the transition by dragging the speed slider to the left or right.  The length of the 
transition is displayed in the lower right  corner. A transition can not be longer than the video clip on which it 
is applied. 

Inserting  a Transition

To apply a transition to a video clip, drag the transition name from the popup list of transitions directly into the 
Clip/Timeline viewer and release it between the two clips you want the transition added to. A transition icon 
will be added between the two video clips.

Rendering  a Transition

Each transition has to be rendered before you can preview it. A red line along the bottom of the transition icon 
indicates the rendering progress. You can continue to work editing other video clips while rendering takes 
place.

Slow Motion/Reverse Direction

To speed up or slow down a video clip, select the video clip you want to edit. Below the Clip/Timeline viewer 
is a slider with rabbit icon (fast) on the left and a turtle icon (slow) on the right. Move the slider to the left or 
right to speed up or slow down the video clip.
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To reverse the direction of a video clip, select the video clip you want to edit. Select Reverse Clip Direction 
from the Advance Menu. The video clip will now play in reverse. 

Filters

Previewing a Filter

Click on the Filter pane. A list of Filters that are available are displayed in a scroll box. When you click a Filter 
name, a preview of the Filter is displayed in the Filter preview window at the top. The Filter preview will 
execute over which ever video clips you have selected.

Adjusting a Filter

Change a setting for a Filter by dragging the appropriate slider to the left or right.  Each Filter has its own 
unique set of options. 

Inserting a Filter

To apply a Filter to a video clip, select a video clip in Clip/Timeline viewer. Choose the Filter you want to 
apply and click the Apply button. You can add a Filter to a section of a video clip by using the In/Out points 
in the Scrubber to select a portion of the video clip. The video clip will be cut into 3 separate clips, the middle 
on will contain the applied Filter.

Rendering a Filter

Each Filter has to be rendered before you can preview it. A red line along the bottom of the video clip  
indicates the rendering progress. You can continue to work editing other video clips while rendering takes 
place.
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Music/Soundtracks

To add sound and music to your imovie you must switch from Clip view to Timeline view by clicking on the 
clock icon button.

There are three separate sound tracks. The top track contains the embedded sound of the video clips (the audio 
recorded by the camera). The middle and bottom tracks can contain music and sound effects. When you create 
a voice over in imovie, it places the resulting sound in the middle track. When you can import files from itunes 
directly into imovie. the imported MP3 files or music from a CD is placed in the bottom track.

Adding Sounds

To add a sound to your iMovie, select the Audio pane from the Pane Menu. At the top of the window, click 
on the popup menu and select iMovie Sound Effects. You will see a list of available sounds displayed as well 
as the duration of each. Position your playhead where you want the sound effect to be inserted. Select the 
sound you want and click on Place at Playhead or you can drag the sound to the middle or bottom track in 
the timeline.
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Adding Music

To add music to your iMovie, select the Audio pane from the Pane Menu. At the top of the window, click on 
the popup menu and select iTunes Library or Audio CD (if you have one inserted). You will see a list of 
available songs/tracks displayed as well as the duration of each. Position your playhead where you want the 
song/track to be inserted. Select the song/track you want and click on Place at Playhead or you can drag the 
song/track to the middle or bottom track in the timeline.

Creating a Voiceover track

To create a voiceover for your iMovie, move the playhead to the position that you want the voiceover to start. 
iMovie uses your computers built in microphone for sound, so when recording speak clearly into the 
computers microphone. If you have an external mic, you can change the sound input setting under the 
computers preferences.

When ready to record click the red record button and begin speaking. When you are finished with your 
voiceover, click the red record button to stop recording.

The voiceover will appear in the middle track where your playhead was positioned. You can move the track 
any where in the time line. 

Extracting Audio from a Video clip

In certain situations you may want to separate your audio from your video clips. To extract the audio from the 
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video clip, Select Extract audio from the Advanced Menu. The audio will be extracted from the video clip and 
placed in the middle track. You can then edit the sound as a separate track

Editing Music/Sounds

To change the length of a sound effect or song, uncheck the Edit volume box. If you do not do this iMovie 
will not allow you to change the length of the file.

Move your mouse to the end of the sound effect or song you want to edit. The mouse changes to a double 
arrow. You can slide the sound effect or song length to the right or left. Keep in mind you can not expand the 
length of the song past its original duration.

To adjust the volume level of a sound effect or song, make sure the Edit volume box is checked. In the 
Timeline viewer click on the horizontal line that runs the length of the sound effect or song. An edit point will 
be inserted in the line. By raising or lowering the edit point, you can raise or lower the volume of the sound 
effect or song. This is effective for creating fade in and fade outs. 

To mute the entire sound effect or song, remove the check from the tracks check box at the far right end of the 
Timeline viewer. The entire sound effect or song can also be adjusted by sliding the Edit volume slider left 
or right.
 

Exporting your iMovie

When your iMovie is finished, you may want export it back to a camera, to VHS tape, a QuickTime movie or 
prepare it for iDVD.

To  export the movie select Share from the File menu. A dialog box displays six chooses.
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Exporting to Email

By selecting Share Email, iMovie will compress a 10 fps (frames per second) 240 x 180 Quicktime movie and 
then open your email client with the movie attached and ready to send.

Exporting to HomePage

By selecting Share Email, iMovie will compress a 12 fps (frames per second) 160 x 120 Quicktime movie and 
upload it to your .mac account.

Exporting to DV Video Camera

By selecting Share Videocamera, iMovie will copy your movie to a digital video camera via the Firewire 
cable. You can set the delay before recording begins and the amount of black before and after the recording 
begins. You must have your camera on and set to playback (VCR) mode. If your camera has a pass thru 
feature, you can use the camera to pass the video thru to a VCR.

Exporting to iDVD

By selecting Share iDVD, you can prepare your iMovie for use in iDVD. Add chapter tracks and more.

Exporting to Quicktime

By selecting Share Quicktime, you get several choices for exporting your iMovie in Quicktime. 
• Email - iMovie will compress a 10 fps (frames per second) 240 x 180 movie.
• Web - iMovie will compress a 12 fps (frames per second) 160 x 120 movie.
• Web Streaming - iMovie will compress a 12 fps (frames per second) 160 x 120 movie with 
   hinted tracks for streaming.
• Web - iMovie will compress a 15 fps (frames per second) 320 x 240 movie.
• Full Quality CD - iMovie will create a loss less DV movie. Good for importing the movie 
   into another application such as Apples Final Cut Pro.

Exporting to Bluetooth

By selecting Share Bluetooth, you can save your iMovie to a compatible Bluetooth device.
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